
Faculty – Develop an open line of 
communication with faculty.  This can 
happen at a local level with campus 
groups or committees.  Otherwise 
on a broader scale, join a national 
organization to collaborate with fac-
ulty from various universities.  Each 
year the Graduate Student Council 
seeks out individuals to be represen-
tatives for each division of AERA.  
This two-year position will allow you 
to work with other students and 
faculty. 
 
 5. Writing a Vita – Meet with a faculty 
member and discuss what a vita 
should look like when applying for 
jobs.  Ask a faculty member if you 
can use his/her vita as an example.  
Have different people offer feedback 
on ways to improve the vita.  Re-
member, a well written cover letter 
is also important! 
 
 4. Interviewing Skills – Practice, prac-
tice, practice.  Before any presenta-
tion for a position, do a few mock 
presentations to other faculty and 
students.  Afterwards, have them ask 
typical interview questions and reflect 
on their feedback. 
 
 3. Deciding on a Dissertation Topic – 
Take different kinds of classes, attend 
conferences, brainstorm with faculty, 
volunteer with an organization, or get 
involved in organizations.  Over time, 
a topic will present itself or the 
choices will narrow themselves 
down. 
  
2. Balancing Family and Friends– Time 
management is the key and knowing 
when to step away from a project or 
paper is important.  Get a daytime 

(Continued on page 2) 

Rachelle Haroldson 
Division I Representative  
University of Minnesota 
 
Tammy Wagner 
Division I Representative 
Capella University  
 

Graduate school is a   

journey with various hurdles 
along the way.  Some journeys 
are small bumps like choosing 
courses and finding a time when 
everyone in the study group can 
meet.  Other hurdles block the 
entire path, like deciding on a 
dissertation topic and conducting 
research.  Of course sometimes 
the hurdles prevent graduate 
students from other important 
aspects of life like family and 
friends.  So how does a graduate 
student go about conducting top-
notch research, publishing, writ-
ing a winning vita, meeting with 
friends and family all while finish-
ing a dissertation?  Here we have 
created a Top 10 List of Ways to 
Overcome Common Hurdles 
(and still have fun in the proc-
ess). 
 
 Top 10 Ways to Overcome 
Common Hurdles in Doctoral 
Programs 
 
 10. Conducting Top-Notch Re-
search – The best way to learn 
how to conduct top notch re-
search is to learn from people 
already doing top-notch re-
search.  Attend specially de-
signed sessions at AERA for 
graduate students called Fireside 

Chats.  These sessions have pre-
senters from all areas of educa-
tion and inform students about 
everything from picking a re-
search topic to publishing re-
search. 
 
 9. Thinking and Writing Criti-
cally – Maximize professor feed-
back by asking them for specific 
advice and critiques on assign-
ments.  After completing an as-
signment make sure to discuss 
the feedback with the professor 
to help clarify ideas to improve 
on other papers and future pro-
jects. 

 
 8. Reviewing Manuscripts – Most 
major journals have opportuni-
ties for graduate students to get 
practice at reviewing articles.  
Contact the editor of the journal 
to find out how to become a 
student reviewer. 
 
 7. Maintaining a Nutritious Diet – 
Yes, despite all the work and 
research that is piling up, it is 
important to eat well-rounded 
meals.  Take a study break with a 
friend and get a warm meal be-
fore digging into that next round 
of journal articles.  The nutrients 
will energize your body. 
 
 6. Understanding Expectations of 
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planner and schedule in time to meet a friend 
for coffee, go shopping with a cousin, take a 
long bike ride, visit the museum with the kids, 
or have a nice home-cooked meal sitting at a 
table with friends and/or family (instead of a 
computer screen). 
 
 1. Persevering to Succeed – Attend an asser-
tive workshop to refresh socially and aca-
demically for professional and personal rea-
sons.  Workshops provide great opportuni-
ties to meet new people, exchange ideas, 
reflect on previous experiences, and prepare 
for new challenges ahead.  If you are looking 
for a conference, remember AERA 2007 is 
April 9-13 in Chicago.   
 
  
 

 

(Continued from page 1) 

Successfully Publish as Graduate Students 
and Junior Faculty Members.” As graduate 
students approach the end of their doctoral 
studies or become newly minted Ph.D.s and 
join the faculty ranks as scholars, we will be 
expected to publish.  Although graduate 
students are immersed in their studies and 
dissertations, students and junior faculty 
should understand how to properly com-
pose proposals and how to publish to gain 
tenure and contribute to their field.  This 
session will feature a workshop atmosphere 
to instruct graduate students and junior 
faculty on how to publish in peer-reviewed 
journals. Topics will include article format-
ting, content, collaboration, the submission 
process, and the review process. 
 
 In addition, this session will showcase  
opportunities graduate students have in the 
peer-review process and Student Editorial 
Advisory Boards.  The GSC recently met 
with the Publications Committee of AERA 
and we were informed that the Committee 
would like more graduate students to par-
ticipate in the peer-reviewer process and 
become members of editorial boards.  One 
of the panelists is a graduate student that is 
currently on the Student Editorial Advisory 
Board of AERA’s Educational Reviewer. 
 
 So, if you intend on going to Chicago for 
the Annual Meeting, make an effort to at-

tend this very informative session.   
 
 

Hugo A. Garcia 
Chair 
Claremont Graduate University 
 
 One of the best rewards for being gradu-
ate student members of AERA is the  
opportunity to meet people from various 
other institutions.  As Chair of the  
Graduate Student Council, I have met sev-
eral graduate students from across North 
America that I can always count on for 
support.  Establishing friendships and a 
network support system in graduate school 
is very important.  I am always amazed at 
the level of collegiality and support that we 
enjoy from one another.  Obtaining a doc-
toral degree is not an easy process.  How-
ever, with the support of fellow doctoral 
students, this process can be greatly en-
hanced.   
 
 Because a lot of the dialog I have with 
other graduate students revolves around 
our dissertation topics and gaining a tenure 
track faculty position, our conversation 
inevitably turns to the issue of publishing.  
This is a very important topic for many 
graduate students and so I have decided to 
conduct a session exclusively on publishing 
as graduate students and junior faculty 
members at the upcoming AERA Annual 
Meeting in Chicago.  The session will be 
titled, “The Publishing Process: How to 

From the Chair 

Overcoming Hurdles  

 
Visit the GSC on the web at  
http://aera.net/Default.aspx?

id=275 
 

 
 
 
 
 
 
 
Learn about the GSC dis-

cussion listserv on our web-
site. 

Graduate Student Seminars  
Many divisions offer seminars at the AERA Annual  

Meeting  for small groups of graduate students  These 

seminars often help students think through their research 

plans, career options, and job opportunities. Divisions 

have a special focus that often parallel student inter-

ests. Some divisions offer stipends to offset expenses  

associated with attendance. If you are interested in apply-

ing for one of these stipends, please check your division’s 

website. Deadlines may be as early as January 2007. 
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 3. Mentoring sessions. Many divisions have 
sessions just prior to or just after the confer-
ence, in which graduate students can engage 
in extended interactions with senior scholars, 
to get guidance on research or to develop 
professional savvy. 
 
 4. Graduate Student Resource Center. This is a 
room set aside just for graduate students, 
where we can hang out, chat, grab a snack, 
get to know students from other universities, 
and find out what interesting things are going 
on at the meeting.  Many of us have found a 
wonderful peer support network just by 
hanging out in this room. 
 

  
5. Career Center. If you are on the job market, 
this is a great resource. Watch the annual 
meeting program for more information. 
 
 6. Graduate student orientation and open busi-
ness meeting/social. If you are a little daunted 
by the size and scope of the annual meeting, 
you can drop in to our orientation, and we 
will help you make the most of your time.  
The open business meeting is an opportunity 

Stacy DeZutter 
Chair-Elect 
Washington University in St. Louis 
 

Now that registration is open for the annual 
meeting, its time to start thinking about  
whether you are coming to Chicago. Even if 
you are not presenting a paper, the annual 
meeting is a valuable opportunity for profes-
sional development and scholarly enrichment.  
Of course, for many graduate students, the 
decision to come to the annual meeting is 
based on whether or not they can get travel 
funding.  And this often means convincing 
your school or a graduate student organiza-
tion that the trip is worthwhile. Here are 
some reasons with which I hope to convince 
you – and help you convince others – that 
you should come to Chicago: 
 
 1. Fireside chats. These sessions are created 
by the graduate student representatives from 
each division, as a way to provide relaxed, 
lively discussion on a topic of interest to 
graduate students.  This year we have an 
exciting array of topics that will help you 
succeed in graduate school and prepare you 
to be part of important conversations in your 
field.  If you come to the meeting and do 
nothing else but go to the Fireside Chats, you 
will leave invigorated and smarter about aca-
demic life. 
 
 2. Professional development courses. These  
extended sessions are designed to train at-
tendees (not just grad students) in a particu-
lar topic, such as a data analysis technique or 
an emerging theoretical approach.  They cost 
extra, but the ones I have taken have all been 
worth it. 
 

for you to get involved with the Graduate 
Student Council – in fact, this is how most of 
the current members got involved.  Of 
course, the social has free food, so need I say 
more? 
 
 7. Receptions. Speaking of free food, many 
groups throw fun, well-stocked receptions 
that are open to all.  Graduate students love 
to reception-hop, and beyond the food, these 
are a great way to network.   
 
 8. Presidential sessions. These are sessions 
designed around the conference theme or 
other pressing concerns.  Attending these is 
a great way to get a sense of the current 
directions in education research. 
 
 9. Chicago. Great food, lots to do, what 
more could we ask? 
 
 10. It’s fun! When I went to my first annual 
meeting, I felt like a kid in a candy store.  
There are so many sessions to chose from—
you can find others doing work similar to 
yours, hear talks from the great minds in 
your field, explore new interests, and meet 
fellow grad students who share your inter-
ests and concerns.   
 
 So, now that you have so many reasons to 
come, I look forward to meeting you in Chi-
cago in April! 

 

About the AERA Graduate Student Council 
 

The Graduate Student Council has five major responsibilities: annual meeting planning, student advocacy, information dis-

semination, community building, and self governance. 

 

The mission of the Graduate Student Council is to facilitate and promote the transition from graduate student to profes-

sional researcher by providing opportunities within AERA for professional growth, development and advancement. In 

addition, the Graduate Student Council seeks to help graduate students navigate the obstacles, rewards, challenges, and 

support networks of academic life. Further, the Graduate Student Council will carry out the mission of AERA through the 

research, scholarship, and professional endeavors of graduate students. 

 

 

Watch this space as well 

as our website for more 

information on running 

for one of our elected 

positions for 2007-2008. 
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Thomas Turner 
Division B Representative 
Arizona State University 
 

Greetings Graduate Students! 

 
  I was invited to write an article that would 
give an overview of the recent AERA  
Graduate Student Council planning meeting, 
held on October 26-27 in Alexandria, VA. I 
know you are busy and probably will not 
read it anyway! So I am choosing to share 
with you an amazing fact I learned at the 
meeting. Of the 20,000 members of the 
American Educational Research Association, 
7,000 of them are GRADUATE STUDENTS! 
Yes, currently we represent a third of the 
membership. Why is this fact so astounding? 
Why is this an amazing time to be both a gradu-
ate student and a member of AERA? Why should 
you even care? Thanks to the dedication and 
hard work of previous graduate students and 
Council members such as the Past Chair 
Diane Jass Ketelhut much of the hard work 
involved with the structure of the graduate 
organization is now in its final stages.  At this 
year’s meeting, the council put the final 
touches on issues such as the Graduate Stu-
dent Handbook, procedure and policy rules 
for elections, and emergency contingencies 
for filling council vacant positions. Now that 
we have a much greater understanding of 
“who we are” it is IMPERATIVE that we be-
gin to receive input from all of you as to 
“what we are”. We need you, our members, 
to give us your opinions on who we should 
be as an organization.   
 
 Towards the end of the meeting the purpose 
and the role of the AERA Graduate Student 
Resource Center was discussed.  In the past 
it has been seen as a place for graduate stu-
dents to come for rest, information, and 
fellowship. At this year’s planning meeting 
several council members expressed their 
desire to re-conceptualize the purpose of the 
room. Suggestions of how that might look 
included using the room for the Fireside 
Chats and/or holding workshops that would 
be of benefit to graduate students. Ulti-
mately, everyone agreed that we need to 
hear from you…each and everyone of you!  
Sadly, that is not happening right now. Last 
year’s AERA Graduate Student Resource 
Center had one of the strongest attendance 
levels on record, yet, that attendance num-
bered in the 100’s when there are 7,000 

members. The hard cold fact is that with 
attendance numbers comes money, work-
shops, presentations, and a stronger voice in 
the overall planning of the conference.   
 
 So how can you become involved? One way 
is to become a Campus Liaison. Campus 
Liaisons serve as an AERA graduate student 
representative at their university. Primary 
responsibilities include disseminating informa-
tion about AERA activities  such as the an-
nual meeting and other professional opportu-
nities for graduate students. If you are inter-
ested in finding out more about Campus 
Liaisons, contact Wendi Laurence, the Com-
munity Leader for the GSC at 
wendil@pdx.edu. Furthermore, feel free to 
stop by the AERA Graduate Student Re-
source Center in the upcoming annual meet-
ing to find out more about this and other 
opportunities to get involved in AERA and 
the Graduate Student Council.  
 
  

So now to answer my previous questions, 
“Why is this an amazing time to be both a 
graduate student and a member of AERA?  
Why should you even care?” As an active 
member of AERA and the Graduate student 
organization you have the opportunity to 
decide on the direction of an organization 
that will not only have an impact on your life, 
but also the lives of our future graduate stu-
dents. Please take the time and initiative to 
get involved and help shape YOUR organiza-
tion! 
. 

Visit 

www.aera.net 

to register for 

the AERA 

Annual 

Meeting in 

Chicago, IL 

April 9- 13, 

2007 



Technology in the Grant Reviewing Process 
 
Vernita Morgan 
Division H Representative 
University of Iowa 
 

Hello AERA family!  I am a second-year doctoral student at the 

University of Iowa majoring in Educational Measurement & Statistics 
with a concentration in Evaluation. 
 
 To answer the question, “what is the role of technology in educational 
research, assessment, and instruction in your field,?” I choose to share 
my personal journey on becoming informed in one of the underlying 
focal points in the field of evaluation - the grant process.  I began my 
journey by taking a Grant Writing Workshop this summer (the files for 
Mr. Ron Mirr’s Grant Writing Workshop can be found at 
http://homepage.mac.com/rmirr). My instructor advised that one of the 
best ways to learn how to write a competitive grant is to review 
grants;  therefore, upon the recommendation of my instructor I sought 
volunteer grant and/or peer reviewer opportunities. I contacted 

friends who worked for non-profit 
organizations and asked if they knew 
of any grant reviewer opportunities. 
They in turn made contacts and 
through this grass roots effort I was 
able to obtain an internship with a 
grant reviewer of a prominent health-
based foundation.   
 
 It wasn’t until my second assignment 

as a grant reviewer that technology 
played a critical role. The five following processes were all integrated 
with technology: 
 

(1) The Application Process – I applied online and even-
tually obtained a paid federal grant reviewer position. 

(2) The Training Process – Training for the reviewer 
position occurred via telephone conference.  Reviewers 
were trained on the grant review process, the criteria 
used to evaluate the grant proposals, and the Grants 
Application Management and Evaluation System 
(GAMES).  GAMES is a web-based tool used by federal 
grant reviewers to document application evaluation 
scores and comments.    

(3) The Review Process and the Final Submission 
Process - The use of technology via GAMES in the grant 
review process has expedited not only the scoring of 
grant proposals but also the feedback to applicants.   

(4) The Discussion Process – A grant reviewer must be 
able to effectively express their ideals and be willing to 
openly listen to the concerns of others during the grant 
reviewer team telephone conference discussions.   

 

My experience as a grant reviewer has been very rewarding. When I  
 
 

(Continued on page 7) 
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One “Not-So-Technical” Graduate Student’s 
Use of Technology during the Dissertation 
Process 
 
Emily J. Shaw 
Division D Representative 
Fordham University 
 

I had a statistics professor who once told our class that the day he 
found out he could perform a Split File function on SPSS he went out to 
the local bars and partied all night.   As graduate students, we have all 
had our moments like that.  Sometimes it is the little things that can 
make our lives and our dissertations so much more manageable -often 
at the click of a button.  Unfortunately, we don’t always know which 
buttons to click, which software to buy, or which people to ask.  This 
article is my attempt  to share some of those “Easy Button” moments 
(a la the Staples ad campaign) with you.   
 
 SPSS Tips   
Spit File-Many of you may al-
ready know, but “Split File” 
allows you to choose a variable 
and analyze your data set by 
each level of the variable.  In 
SPSS, go to Data→Split 
File→Compare Groups→(drag 
the variable you’d like to com-
pare into “Groups Based 
On”)→click OK→ then 
choose your analyses and view 
output by groups. 
 
Variable View-Sometimes you’d like to easily  view or print the data in 
“variable view” to quickly see how many or what types of variables are 
in your database.  In order to do this, go to File→Display Data File 
Information→Working File.   
 
SPSS Tables –You can format your output to tables in a way that is 
consistent with APA style. Click on Analyze→Tables→Custom Ta-
bles→(creates your desired table) →(double-click on the table you 
created) →Format→Table Properties→(adjust the borders and font to 
be consistent with APA style). 

New Syntax-Creating new variables through the “Recode” drop-
down menu can be somewhat limiting, you can open up a 
new syntax window (FILE→NEW→SYNTAX) and create 
new variables using an IF statement.  For example, the fol-
lowing command, IF (var1= 1 AND var2 > 50) group = 
2., creates a new variable (group 2) if and only if the rela-
tional expressions within the parenthesis are true.   

 
Excel Tips 

• When you create a formula to be carried down the length of  

a column, you can simply double-click the “cross” at the bottom right-
hand corner of the cell that contains the formula and each cell in the 
column for which the corresponding input data exists will be filled. 

(Continued on page 7) 

“What is the role of technology in 

educational research, assessment, 

and instruction in your field?”  



as a place to obtain just-in-time information rather than a place to 
engage in deep, reflective learning. It’s likely that many factors—
including grades, professional development points, and peer culture—
may influence educators’ willingness to engage in reflection online, and 
this strikes me as an interesting area for further study. However, it’s 
also likely that educators’ hesitation toward online reflection and col-
laboration will diminish as the youth reared on instant messaging and 
MySpace become the educators of tomorrow. 
 
Footnotes: 
 
1 Whitehouse, P.L., Breit, L.A., McCloskey, E.M., Ketelhut, D.J. & 
Dede, C. (2006). An overview of current findings from empirical re-
search on online teacher professional development. In Online profes-
sional development for teachers: Emerging models and methods (pp. 13-
29). Cambridge, MA: Harvard Education Press. 
 
2  Ketelhut, D.J., McCloskey, E.M., Dede, C., Breit, L.A., & White-
house, P.L. (2006). Core tensions in the evolution of teacher online 
professional development. In Online professional development for teach-
ers: Emerging models and methods (pp. 237-263). Cambridge, MA: Har-
vard Education Press. 
 
3 Steele, J.L. (2005, April 13). District  administrators’ experiences of an 

online professional development work-
shop. Paper presented at the annual 
meeting of the American Educa-
tional Research Association, Mont-
real, Canada.  
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How Have New Information Technologies  
Affected Educator Professional Development? 
 

Jennifer Steele 
Program Chair 
Harvard University 
 

One of ways in which new information technologies are reshap-

ing the educational landscape is through the rise of online learning. The 
increasing sophistication of digital media, including streaming video and 
podcasts, and the expansion of broadband Internet access have made 
online learning an increasingly viable choice for people wishing to pur-
sue additional schooling. While current forms of online learning are 
more prevalent in professional and higher education than at the K-12 
level, the impact of online learning has not completely bypassed K-12 
schools.  Today, virtual high schools provide some students with a 
distance learning option, and home-schooling-support websites provide 
resources to students schooled outside the traditional system.   
 
 In some cases, distance learning is also reshaping the way educators 
enhance their own skills. Re-
cent years have seen an in-
crease in professional develop-
ment courses available online 
for teachers and administra-
tors. A recent review of forty 
empirical studies of online 
teacher professional develop-
ment found a wide range of 
models in use, including those 
that emphasized constructivist learning, adult development, mentoring, 
and communities of practice. The review found that roughly half of the 
models focused on particular content areas such as math, science, 
English language arts, or foreign languages, while other models focused 
on general teacher education, or on particular cross-disciplinary skills 
such as special education instructional strategies or integrating technol-
ogy into the classroom. The reviewers also identified several core 
tensions in the field, one being the tension between design for incre-
mental learning and design for transformation. In other words, many 
online professional development programs find audiences by offering 
skills that teachers can put to immediate use in the classroom.  Pro-
grams that challenge teachers to rethink their pedagogical approaches 
may have greater long-term importance for improving educational 
practice, but they may find it difficult to sustain teacher engagement 
over the longer term required to transform practice. 
A similar tension emerged in a study I conducted in 2004 of an online 
professional development program for school district administrators. 
By monitoring participation patterns and interviewing participants, I 
found that the busy administrators preferred course components that 
were easily downloadable and quickly applicable to their daily practice, 
and that they viewed reflective and collaborative components like es-
says and threaded discussions as poor uses of their scarce time. 
 
 I currently administer the online component of a hybrid, face-to-face 
and online course for aspiring school administrators. In that situation, I 
also find that for educators whose time is already stretched too thin, 
the requirement for reflective online collaboration and discussion can 
be seen as a distraction. It seems that many educators see the Internet 

“What is the role of technology in 

educational research, assessment, 

and instruction in your field?”  

 



date).  There may ultimately be over 60 versions of your dissertation, 
but there will also be an impeccable archive of the many stages and 
versions that your paper has gone through. 
 
Footnotes: 
Special thanks to Division D graduate students and members who 
contributed to this list, including Sandra Barbuti, Krista Mattern Bur-
rus, Doreen Finkelstein, Haifa Matos, Brian Patterson, Sheryl Rosen-
thal, and Jeff Wyatt. 
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“Not-so-technical” 
Continued from page 5 
 

• CTRL + PAGE DOWN = Move to next worksheet 

• CTRL + N = Opens new workbook 

• SHIFT + F11 = inserts new worksheet in your workbook 

• CTRL + spacebar = selects entire column 

• SHIFT + spacebar = selects entire row CTRL + ; = enters current 

date 
 
 SAS Tips 

• Many graduate students need an easy way to identify duplicate 

records in a database.  There are two main varieties of duplicate re-
cords: exact duplicates and sort-key duplicates. Duplicates on some series 
of identifying variables—also known as a “sort key”.  One simple way 
to check for exact duplicates in SAS is to issue the following proc step: 
 
PROC SORT DATA= Original OUT= Original_Without_Dupes_1 
NODUP; BY ID_Var_1 ID_Var_2 … ID_Var_n; RUN;  
 
If on the other hand you want to detect duplicates by a limited series 
of identifying variables in SAS, then the following proc step is appropri-
ate: 
 
PROC SORT DATA= Original OUT= Original_Without_Dupes_2 
NODUPKEY; BY ID_Var_1 ID_Var_2 … ID_Var_n; RUN; 
 
The difference between these two procedures is that the first will only 
remove exact duplicates by ALL variables in the dataset including those 
not listed on the BY line and the second will remove only duplicates by 
those variables listed on the BY line, regardless of the values of the 
other variables in the dataset.  Either of these statements will start 
with the dataset “Original” and will create a new dataset from which 
the duplicates have been removed and the log file will indicate how 
many duplicate records have been deleted.  Finally in either case, the 
first of the duplicate records is the one that is retained. 
 
 Other 

• While people have many different purposes for using online sur-

vey software, something that my colleague and I have noticed is that 
the skip logic function in Zoomerang is much easier and intuitive to 
work than the skip logic in SurveyMonkey. 

• SurveyShare probably has the most flexibility in designing questions 

(between Zoomerang, SurveyShare, and SurveyMonkey), but it doesn't 
allow sharing results. 

• The main reason that some people prefer SurveyMonkey over 

Zoomerang is that the range of question types it allows is larger and 
more flexible.  SurveyMonkey also allows you to: (1) put in a date for 
the survey to automatically stop accepting new data rather than having 
to go onto the site and stop it manually on that date; (2), make the 
survey password-protected (person needs a password to take the 
survey) if you choose; and (3) share results without the com-
pany's brand ("SurveyMonkey" or "Zoomerang") on the page.  Either 
Zoomerang doesn't allow the above or they're difficult to do because I 
know someone who has looked very hard and couldn't find a way to 
do them. 
• It may be useful to you to save your dissertation as a new file 

each time you’ve worked on it (under a file name that includes the 

Grant Writing 
Continued from page 5 
 
do decide to write a grant I will have first hand knowledge on what 
reviewers look for in a successful grant proposal.   
 
 Familiarization with the grant process is just one of the many di-
verse areas within Division H; I invite you to become acquainted 
with other opportunities at: 
http://www.aera.net/uploadedFiles/Divisions/School_Evaluation_ 
 
&_Program_Development_(H)/DivH-Overview.pdf  
 

 
 
 
 
 
 
 
 
 
 

 

 
Do you have suggestions for future 
“Connections Across Divisions”  

columns or other newsletter-related 
recommendations?   

Email your ideas to the Newsletter 
Editors,  

Ingrid Salamanca 
(isalaman@education.ucsb.edu) and 

Sheila L. Sherman 
(ssherman@msu.edu). 



OFFICERS 

 

Chair 

Hugo A. Garcia 

Claremont Graduate School 

garciah@cgu.edu 

 

Chair-Elect 

Stacy DeZutter 

Washington University in St. Louis 

SLDeZutter@aol.com 

 

Past Chair 

Diane Jass Ketelhut 

Temple University 

diane@alumni.brown.edu 

 

Secretary–Historian 

John Oliver 

Michigan State University 

oliver10@msu.edu 

 

Web Secretary 

Alex Bowers 

Michigan State University 

bowersal@msu.edu 

 

Newsletter Editor 

Ingrid Salamanca 

University of California Santa Barbara 

isalaman@education.ucsb.edu 

 

Newsletter Editor 

Sheila L. Sherman 

Michigan State University 

ssherman@msu.edu 

 

Program Chair 

Jennifer Steele 

Harvard University 

steeleje@gse.harvard.edu 

 

Community Leader 

Wendi Laurence 

Portland State University 

wendil@pdx.edu 

 

Council Liaison 

Carol D. Lee 

Northwestern University 

cdlee@northwestern.edu 

 

 

Graduate Student Council Roster, 2006-2007 

Division A 

Leslie Hazle Bussey 

Saint Louis University 

lhbussey@mindspring.com 

 

Christi Ford 

University of Missouri 

cdfp5f@mizzou.edu 

 

Division B 

Thomas C. Turner 

Arizona State University 

Thomas.C.Turner@asu.edu 

 

Rowena Xiaoqing He 

University of Toronto  

xhe@oise.utoronto.ca 

 

Division C 

Juan Barrientos 

New York University 

jaunb@nyu.edu 

 

Dana K. Manning 

Texas Tech University 

dana.k.manning@ttu.edu 

 

Division D 

Dirk Richter 

Ohio State University 

Richter.63@aol.com 

 

Emily Shaw 

Fordham University 

emshaw@fordham.edu 

 

Division E 

Seleena Smith 

University of Oklahoma 

seleena_smith@ou.edu 

 

Rebecca Hurst 

University of Oklahoma 

rhurst@ou.edu 

 

Division F 

Lori Rhodes 

Stanford University 

hit_the_rhodes@gmail.com 

 

Katherine Sedgwick 

University of Pennsylvania 

ksedgwic@dolphin.upenn.edu 

 

Division G 

Minda M. Lopez 

University of Texas, San Antonio 

minda@satx.rr.com 

 

Jevon D. Hunter 

University of California Los Angeles 

hunterj@ucla.edu 

 

Division H 

Colleen Paeplow 

North Carolina State University 

cpaeplow@wcpss.net 

 

Vernita Morgan 

University of Iowa 

vernita_morgan@uiowa.edu 

 

Division I 

Rachelle Ann Haroldson 

University of Minnesota 

haro0032@umn.edu 

 

Tammy Wagner 

Capella University 

swagner@maqs.net 

 

Division J 

Christopher Coogan 

University of Florida 

coogan@ufl.edu 

 

Cassandra Lewis 

University of Maryland College Park 

CLewis@umuc.edu 

 

Division K 

Kristen French 

University of Masachusetts-Amherst 

kbfrench@educ.umass.edu 

 

Juanita Perea 

California State University, Monterey Bay 

Juanita_perea@csumb.edu 

 

Division L 

Angela Hull 

University of Missouri–Columbia 

amhd7f@mizzou.edu 

 

William Kyle Ingle 

Florida State University 

wki02@garnet.acns.fsu.edu 
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